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How to create skins and splashes

Both skins and splash screens can be created using the Skinner Desktop software that is part of the 
Skinner for Treo 680 download. 

The task of Skinner Desktop is not to supply you with an image editor, but rather to take a set of 
images and put it together into a skin. This allows you to use the image editor of your choice, for 
example Photoshop, to fine-tune your skin.

This document tries to outline a few basic rules and tips on how to create your own files. Please also 
refer to the manual for instructions on how to use Skinner on your Treo 680, as well as for support 
and contact information.

Creating splash screens

Creation of splash screens is very simple. You just need two image files which will be used as the 
images that are displayed when your Treo’s phone is turned on or off (so called splash screens, 
carrier logos or welcome/goodbye screens). 

The image files need to be
• JPEG only
• 320x320 pixels in size
• max. 16 bits in colordepth
• less than 64 kB in size each

The files will be included in the splash file without any modification, so please make sure that you 
have a correct JPG file. Skinner Desktop will do a basic check to see if the images are in the correct 
size (320x320 and less than 64kB) and in JPG-format. If any of these conditions is not fulfilled, the 
splash file will not be created.

No scaling will be done, so if you have a photo that you want to use as splash screen, you will have 
to use an image editing software like GIMP or Photoshop to adjust the image size to 320x320 
pixels.

That's  basically  all  there  is  to  say  about  splash  screens.  The  rest  of  this  How  To  will  thus 
concentrate on some basic techniques on how to easily create a skin for the phone application of 
your Treo 680.



Creating skin files

Skin files are harder to create than splash screens, as a skin consists of 40 different images. Here’s a 
quick overview:

• 1 bitmap for the dialpad button
• 1 bitmap for the dialpad button pressed down
• 12 bitmaps for the text on the dialpad buttons
• 12 bitmaps for the text on the pressed dialpad buttons
• 2 bitmaps for the favorites buttons (normal and selected)
• 12 bitmaps for the tab section

As pressed and unpressed buttons and texts can be set separately, a 3D effect can – for example - be 
achieved for button presses by displaying text and inverting the border of the button.

All these bitmaps can be specified separately and need to be supplied in the correct size and in BMP 
format. Some of these bitmaps can be created automatically from a larger bitmap, which we will 
explain further below.

For  all  of  these  bitmaps  Skinner  Desktop  allows  you  to  specify  the 
transparency. Transparency is specified by selecting the color that should be 
transparent (see-through). 

Example for transparency: Consider the image to the right which is a white 
circle  on  a  green  rectangle.  If  you  were  to  paint  this  image  on  a  blue 
background with no transparency, you would get the result as shown in the 
left picture below.

But if you set green as transparent color, painting the image on the blue background would let the 
background be visible where the green was before as you can see in the image to the right.

You  want  to  use 
transparency  whenever 
images  are  supposed  to 
overlap and the image  on 
top  contains  unused  parts. 
The  preview  in  Skinner 
Desktop  will  give  you  a 
realistic  preview how your 
skin is going to look so you 
can  experiment  with  the 
transparency settings to see 
the difference.

One caveat with transparency is that it only covers one colour. If the borders are dithered, they will 
most likely contain pixels of colors close to the transparent one and you may see artefacts – for 
example you may see that there is still green and some white in the picture to the right. Use the 
magnifier in your image editing software to see and erase these pixels.



Loading and saving skins

Skinner  Desktop allows you to load existing skins (created with Skinner Desktop only) and to 
modify them. This obviously is especially useful when you have downloaded a skin that you like 
and only want to make some small adjustments. For copyright and intellectual property reasons, 
please check with the author of the original skin, however, before you make your modified skin 
available to the public.

Creating a skin using single bitmaps

The historic way of creating a skin was to modify each of the aforementioned bitmaps to your 
liking. To aid you in this, use the “Export Bitmaps” menu item to have Skinner Desktop create all 
40 bitmap files for you in the correct dimensions.

After  you  are  done  modifying  the  images,  you  can  load  them back  into  Skinner  Desktop  by 
selecting “Import Bitmaps” from the menu and files with the same filename used during the export 
will be loaded. Please note that transparency colors will have to be selected in Skinner Desktop 
manually.

Creating a skin using combined images

Alternatively, Skinner Desktop allows you to create the dialpad 
in one step using one single image (306x216 pixels). This allows 
you to create a bitmap containing the complete dialpad in one go.

For example, you could create a dialpad as shown to the right 
and load it in Skinner Desktop via “Import dialpad bitmaps ...”. 
You will be asked to select two bitmap files – one for the dialpad 
with unpressed, and one for the dialpad with pressed buttons. If you do not care about 3D or other 
effects when pressing a button, you can of course load the same dialpad image twice.

Technical background

On the device, the buttons will be drawn by displaying first the 
button graphic and afterwards painting the button text on it. As 
you  see  in  Skinner  Desktop,  there  is  only  one  button  image 
defined which will be used for all 12 buttons on-screen.

What  is  unique  for  each  button,  though,  is  the  text.  As  it  is 
impossible  for  Skinner  Desktop  to  separate  the  button  image 
from the text if you load the dialpad as one image, what will be 
done is  to erase the button image to an all-white  bitmap and 
putting all the information in as the dialpad text images.

So when you load a dialpad image, it will be split into twelve 
parts,  the dialpad button images will be erased and the dialpad text images will be set  to these 
twelve  parts.  Please  note that  some  dialpads  need  to  have  their  transparency  set  afterwards 
(especially dialpads with white text).

Using this trick, it is also possible to create skins that seem to have a background by loading a 
corresponding dialpad. Or use the “Insert background image...” feature in Skinner Desktop to insert 
the background image behind the dialpad buttons and text. Read below for more information on 
how this can be done.



Menu commands – An overview 

Skinner Desktop provides the following menu commands:

For splash file creation:

Open – open a splash file
Save – save the current splash file
Save as... – save the current splash file under a new name

Work on Phone application skins – Goes to the skin editor
Exit – Quits Skinner Desktop

For skin file creation:

Reset – Sets all bitmaps back to their default
Open – Loads a skin
Save – Saves the current skin
Save as... – Save the current skin under a new name

Work on Splash Images – Goes to the splash editor
Exit – Quits Skinner Desktop

Export Bitmaps... – Saves all parts of the skin as single BMP 
files  for  modification.  You  will  be  prompted  for  the 
directory to save the bitmap files into. After you have 
modified them, you can load them back using 'Import 
Bitmaps ...'

Export Dialpad Bitmaps ... – Saves the complete dialpad area 
as  one  image  (e.g.  suitable  for  modification  in 
Photoshop/GIMP)

Export Preview... – Saves a screenshot (useful if you want to 
show your skin at your website)

Import  Bitmaps...  –  Loads  all  bitmaps  for  a  skin  (same 
filenames  as  created  by  'Export  Bitmaps'  above.  You 
will be prompted for the directory that contains the bitmaps.

Import Dialpad Bitmaps... –  This will load two bitmaps, one for the dialpad with the buttons not 
pressed, one for the dialpad with the buttons pressed. The images have to be 306x216 in size 
(width x height) and will be split in twelve parts and assigned to the dialpad text bitmaps (the 
dialpad button bitmaps will be set to all-white).

Insert Background Image... – You will be prompted to select one 306x216 bitmap which you want 
to use as background. On this image, the dialpad button image (if any) and the dialpad text 
images will be drawn. Afterwards the image will be split into twelve parts and assigned to the 
dialpad text bitmaps (the dialpad button bitmaps will be set to all-white).



Tips and Tricks to create a custom skin

The ideal way to create a good skin is to create all of the 40 different parts (bitmaps) of the skin 
separately so that they – when put together – form a beautiful skin. This requires talent, good skills 
with applications like Photoshop and is usually quite a bit of work. Describing all the tricks on how 
to create a perfect looking skin from scratch is not possible on these few pages. What we are going 
to do, however, is to show you how to create a custom skin by using existing features and some 
simple techniques.

There are a number of certain scenarios that are common when a user of Skinner for Treo 680 wants 
to create his own skin. The most common one is the wish to add a background image to the dialpad. 
Another common scenario is that users are looking for a skin with a certain theme. The following 
pages will try to cover these two common scenarios.

How to add a background to a skin ...

As the phone application does not support a background image for the dialpad (mainly because the 
default buttons are so big that a background image would not be visible), placing a background 
image on your skins can be a bit tricky. Yet, it is possible if you can live with the restriction that it 
will not be full screen but will only cover the dialpad area.

For this example, we are going to use the picture to 
the right as background image. This should also be 
your  first  step:  prepare the background image that 
you want to use. The image needs to be 306x216 in 
size (width:  306, height:  216 pixels)  and stored in 
BMP format (16 bit color depth).  Use your favorite 
image editor or album application to scale or crop 
larger images and to convert i.e. JPG to BMP.

The second step is to decide upon the buttons you 
want to use. Either create your own ones, use an existing skin or use one of the sample dialpads that 
are included in the “Dialpads” directory (load them via “Import dialpads ...” in the menu).

The third step is to combine both the background and the buttons.  There are several alternatives 
depending on what you imagine and what kind of buttons you selected. 

The simplest approach to add the background to the skin is using the “Insert Background Image...” 
menu command. This will put the dialpad buttons and the dialpad texts on top of your background 
image. Of course, this requires that your dialpad buttons and text have sufficiently large transparent 
parts, otherwise there will not be a lot visible from your background image. You can also have 
problems with buttons that have dithered edges or shadows, if the background image's colors do not 
match the buttons. More to that later.

To show you what this approach could look like, we have added the above background image to the 
Western skin as well as to a dialpad that only has text but no button frame, both times using the 
“Insert Background Image...” menu command of Skinner Desktop:



As you can see, the Western skin's buttons are too large to allow for a good view of the background 
image (though it's not that bad). The screenshot on the right side shows a text-only dialpad which 
allows the background image to be better visible. For the title bar and favorites buttons, use one of 
the existing skins.

Solution  #1  is  an  easy  approach  and  gives  you  results  very  fast.  Unfortunately  it  has  some 
drawbacks. To make text look smooth, dithering or anti-aliasing is used. This basically means that 
the edges of the letters are painted in a “fuzzy” way (the edges do not have a sharp black-to-white 
transition but there is an area with a mixture of white, light-grey, dark-grey and black pixels. 

Use of this trick has a big drawback when you paint this text (i.e. dialpad) on a background image. 
Depending on the exact colors and amount of “fuzziness”, the edges of the text may seem distorted 
and rough. To reduce this effect, you can use an image editor like Photoshop or GIMP and either do 
the backdrop in it (smoothing the edges) or print your own text directly (perfect edges).

As we are at the image editor software already, let's stay there and read about the second possibility 
to  add  a  background.  This  more  advanced approach is  not  actually  very  difficult  either,  but 
requires slightly more work and you may need to experiment a bit more. We will show you how to 
use an existing dialpad from a skin – which even may fill the whole dialpad area – and to add a 
background image to it using semi-transparency (and a concept called alpha-blending).

This time, the background image should shine through the buttons. This is the ideal solution for 
every kind of dialpad. Let's show you a few examples first of skins with a complex dialpad and 
some custom backgrounds:

We have used a western dialpad with our company logo and put them together. You can see that the 
background image (the hand) is visible through the buttons. You may also notice that the quality of 
the resulting dialpad depends on the amount of blending and the background and button images. A 

Solution #1:  To quickly create  a skin using your favorite  background, follow 
these steps:

1. Load a skin of your choice that has a tab bar and favorites buttons that 
you like (or create your own). 

2. Either keep the buttons of that skin (check transparency of the dialpad 
buttons!)  or  use  “Import  Dialpad  Bitmaps...”  to  load  a  predefined 
dialpad from the “Dialpads” directory (recommended). If you do the 
latter,  choose  a  dialpad  with  dark  text  for  bright  backgrounds,  and 
choose a dialpad with bright text for dark backgrounds.

3. Use “Insert Background Image...” to have Skinner Desktop insert your 
background image. Skinner Desktop will show you what the skin will 
look like on your device.

4. Use “Save as...” to save the skin under a new name and install it to your 
Treo 680.



rule of thumb here is that mixing two complex pictures (i.e. a photo as background and a set of 
fancy button images) may not produce very good results.

But let's get to the interesting point on how to actually create these dialpads. We will explain this 
twice – first using GIMP, afterwards using Photoshop.

For GIMP, please load the “Skin Template for GIMP.xcf” file that you can find in the “Templates” 
directory. This will open an image in the correct size (306x216) which has two layers predefined. 
The top layer is for the background image, the bottom layer is for the dialpad. 

In parallel, please open the background image (306x216 pixel) and the dialpad that you want to use. 
You can use one of the existing dialpads in the “Dialpads” directory, copy a dialpad from another 
skin (use the “Export Dialpad Bitmaps ...” menu item in Skinner Desktop) or use your own dialpad.

Copy the dialpad image that you opened into the dialpad layer, and the background image into the 
background layer. You can do this the following way:

1. Select the window with the image. Right-click into the image and select “Selection -> 
All”  (or  simply  press  Ctrl+A).  Afterwards,  right-click  and  select  “Edit  ->  Copy” 
(Ctrl+C).

2. Select the window for your skin. Left-click on the corresponding layer and left-click once 
the titlebar of the skin window. Right-click into the image and select “Edit -> Paste” 
(Ctrl+V). Right-click into the image and select “Layer -> Anchor layer” (Ctrl+H).

After you are done, select the background layer and use the slider above it to change how much the 
background should shine through. You could also experiment with other layer modes (by default 
the template file included with Skinner Desktop uses “Multiplication”).



If you want some 3D or shading effect when you press a dialpad button on your Treo, you will need 
to  repeat  this  for the dialpad with pressed buttons.  Otherwise you can of course use the same 
dialpad for pressed and unpressed.

When you are done, save the file as bitmap and use the “Import Dialpad Bitmaps...” menu item in 
Skinner Desktop to load everything into your skin. That's it.

Doing the same in Photoshop is very similiar. Please load the file “Skin Template for Photoshop 
CS.psd”. This will open an image in the correct size (306x216) which has two layers predefined. 
The top layer is for the background image, the bottom layer is for the dialpad. 

In parallel, please open the background image (306x216 pixel) and the dialpad that you want to use. 
You can use one of the existing dialpads in the “Dialpads” directory, copy a dialpad from another 
skin (use the “Export Dialpad Bitmaps ...” menu item in Skinner Desktop) or use your own dialpad.

Copy the dialpad image that you opened into the dialpad layer, and the background image into the 
background layer. You can do this the following way:

3. Select the window with the image. Right-click into the image and select “Select All” (or 
simply press Ctrl+A). Afterwards, select “Copy” from the “Edit” menu (or simply press 
Ctrl+C).

4. Select the window for your skin. Left-click on the corresponding layer on the right and 
left-click once the titlebar of the skin window. Select “Paste” from the “Edit” menu (or 
simply press Ctrl+V). Select “Merge Down” (or simply press Ctrl+E).

After you are done, select the background layer and use the “Opacity” slider above it to change how 
much the background should shine through. You could also experiment with other layer modes (by 
default the template file included with Skinner Desktop uses “Multiply”).

If you want some 3D or shading effect when you press a dialpad button on your Treo, you will need 
to  repeat  this  for the dialpad with pressed buttons.  Otherwise you can of course use the same 
dialpad for pressed and unpressed.



When you are done, save the file as bitmap (“.BMP”) and use the “Import Dialpad Bitmaps...” 
menu item in Skinner Desktop to load everything into your skin. That's it.

Creating theme skins

Now that we have covered the background image, let's shortly tackle the topic of creating your own 
theme skin. This requires a bit more of work, so we won't go into a lot of details as every theme and 
every skin will require a different approach based on your expectations.

Theme skins are skins with a topic – for example operating systems (e.g. PocketPC, Treo, MacOS 
X), holidays, Sports teams, games (e.g. Poker), seasons (e.g. Winter), and so on.

You probably  already know the  theme you are  going for  and you will  have to  create  suitable 
images. 

Creating a themed dialpad can vary in complexity from very easy 
to very difficult. The most basic approach is to just use a suitable 
background image (for example with the logo of your company, 
the logo of your favorite sports team, a picture of a dog, etc) and 
create a dialpad as outlined on the previous pages.  

One example for this would be the dialpad to the top-right, where 
we used the Western skins'  dialpad and put our company logo 
behind it.  Another example could be the skin to the right that 
makes use of a background image to give you a winterly theme. 
As you see it also uses custom dialpad text images, but of course 
you could just go with one of the available dialpad bitmaps that 
are included with Skinner Desktop.

For more abstract themes, you will need to create keypad button 
images  (and  probably  associated  keypad  text  images) 
individually. Use the “Export bitmaps...” menu item in Skinner 
Desktop to have the images created for you in the appropriate 
dimensions  and  use  GIMP/Photoshop/...  to  modify  them.  The 
example to the right is a Poker theme skin with custom dialpad 
button and dialpad text images.

The tab bar images need to be modified in Photoshop/GIMP/... as well, to match the dialpad in 
theme and color. How you do that depends on the theme and your requirements. In the simplest 
case, you could just take the images from another skin and add a little something to it – for example 
a small image at the left-side. 

The same goes for the favorite buttons. Either create your own one or re-use the buttons of an 
existing skin. 

Solution #2: To create a skin with semi-transparent buttons (or simply for more 
control),  use Photoshop, GIMP or any other good image editing software and 
apply alpha-blending (see  above for  instructions)  or  any other  filters  that  you 
need. Use your custom background image (306x216) and a dialpad of your choice 
(either from our collection, another skin or one of your own creations).



What you should always consider is having some kind of effect when pressing a dialpad button. 
You can create this by using different dialpad images (i.e. using different dialpad button images 
and/or text images). In the simplest case you could just shade the graphics for the pressed buttons, if 
you want a 3D effect you will need to modify the pressed button image accordingly.

Information for the Tab Bar

If you want to perfect your skin after having designed the dialpad, you definitely want to redesign 
the tabs at the bottom of the screen. Using Skinner Desktop, this is very straightforward, but there 
are some small things you may want to be aware of beware tackling this step:

 In the default layout, the vertial separation lines between two unselected tabs is not an extra 
image, but is rather part of the tabs itself – the left tab has half of the vertical line, the right 
tab the other half and together they form the vertical separation line you can see. Of course, 
it is up to you how you are going to design this – you could have no separation, empty space 
or put the separation line in either of the tabs.

 The phone application assemble the tab bar  by drawing the left  border  image (4 pixels 
width), followed by the 5 tabs unselected (62 pixels each) and finally the right border image 
(6 pixels). When the selected tab is drawn, it will partially paint over parts of the tabs on its 
left and right as it is 12 pixels wider than the unselected tab – hence 6 pixels of the tab to the 
left and 6 pixels of the tab on the right will get lost in this display. The Skinner Desktop 
shows you a preview for when the left- and the right-most tab is selected.

This is the end of our little workshop on “How to create skins and splashes”. We hope that you have 
learned a few basic ideas and how to quickly add a custom background image to any skin (and how 
to easily create your own background image skin).

For information on Skinner for Treo 680 itself, including contact/support information, please refer 
to the manual.pdf file that is part of this download as well.
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